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Processing a new shipment from NEON 
 

Domain folders 
A template Domain folder is in the shared Google folder designed as “NEON_year”. The template folder 
contains four folders and two files. The folders are:  

1. Identified and Billed: As material for that Domain has been identified and billed to NEON all of 
the files get saved into this folder. 

2. Manifests: The shipment manifests attached to the Chain of Custody emails get saved here. 
3. Receipts: The receipt files attached to the Chain of Custody emails get saved here. 
4. Site Upload: Site upload files generated for ingest into the USNTC database are saved here. 

The files are: 
1. _current 
2. _RMLs for printing 

Both of these files should be renamed to contain “Domain #” for the domain the main folder is being 
created for. These files contain the correct formatting for those files. 
 

Chain of Custody Emails 
Upon shipment from a domain, a Chain of Custody email is created. This email contains both a manifest 
for the shipment and a receipt form. Download both of these files to the folder for that Domain. 

 

Receiving a shipment 
1. Shipments are sent to us by the NEON domains. Upon shipment, a Chain of Custody email is 

created which contains both a manifest and a receipt file. 
2. As soon as possible, pick up the shipment from the front office and bring to the lab. 
3. Compare the contents of the package to the Receipt file attached to the Chain of Custody email 
4. Fill out the Receipt file using the information in Table 1 on page 2. 
5. Save the Receipt file as a CSV. Do not change the file name. 
6. Upload the Receipt file to the data portal* at: http://data.neonscience.org/web/external-lab-

ingest/ 
7. Some packages will contain a return shipping label. After removing the samples, replace all 

packing material in the package, seal it back up, and tape the return shipping label to the 
outside of the container. Be sure to remove the previous shipping label! 

8. Bring the package to Melissa so she can schedule a pickup. 

 

*Note:  You must have an account with NEON in order to access the data portal. As of August 2018, only 
Lorenza has account. 
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Table 1: Data Dictionary for Receipt files 

Field Format Required? Example Remarks 
ShipmentID Alphanumeric -- D0220180806121654937 This field is already populated by 

NEON  
shipmentReceivedDate YYYYMMDD Y 20180813  
receivedBy xxxxx@xxxx.com Y crevans@georgiasouthern.edu Email address of the receiver 
sampleID Sitecode.YYYYMMDD -- SERC_005.20180430 This field is already populated by 

NEON 
sampleCode Prepopulated -- A00000001185 This field is already populated by 

NEON. Barcode number on 
sample vials. 

sampleReceived Y/N Y Y  
acceptedForAnalysis Y/N N Y REQUIRED if sampleReceived is 

'Y', choice of 'Y' or 'N'. If 
sampleReceived is 'N', leave this 
field blank. 

sampleCondition Cold chain broken; 
damaged; sample 
incomplete; handling 
error; other 

N Damaged REQUIRED if 
acceptedForAnalysis is 'N', leave 
this field blank otherwise. If a 
sample is not fit for analysis, 
please document the reason 
why in the sampleCondition 
field. If selecting 'other', include 
a description of the problem in 
the remarks column. 

unknownSamples Sitecode.YYYYMMDD N SERC_005.20180430 Add the sampleID of all samples 
found that do not correspond to 
any provided sampleID or 
sampleCode. Please also notify  
CLA_admin@battelleecology.org 

Remarks Text N --- usually optional, REQUIRED if 
sampleCondition is 'other' 
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Assigning RMLs 
1. Open the manifest attached to the Chain of Custody email in Excel. 
2. Open the current Google Drive file for RMLs*. This file is in the RML, Jar Numbers, etc. folder. 
3. Scroll to the last used number in the document. 
4. Copy the vial IDs and sampleCodes from the Excel file 
5. Paste so the vial IDs are in the vialID (NEON) column and the sampleCodes are in the next 

column. (Right click on the cell that you are pasting into. Choose Paste specialPaste values 
only.) 

6. The RMLs are now considered assigned. 

Domain Data Files 
1. In the folder for that Domain, open the Domain #_current file.  

Note: If this is the first shipment for a Domain, this file may only contain column headings.  
2. Copy the vialIDs, sampleCodes and RMLs from the Google Drive RML file into the _current file. 

Do not paste over existing data (if any). 
a. vialID into column B (sampleID) 
b. sampleCodes into column C (sampleCode) 
c. RMLs into column D (RML-temp, remove before sending to NEON) 

3. Save the file. 
4. Save the file a second time using the following format: 

a. Domain #_DDMonYYYY  
(the date is the current date with numbers representing the day and year and the first 
three letters of the month) 

Print RMLs 
1. In the folder for that Domain, open the Domain #_RMLs for printing file.  

Note: If this is the first shipment for a Domain, this file may be blank. The formatting is still 
there! 

2. Copy the sampleIDs and RMLs from the _current file and paste them into the _RMLs for printing 
file.  

a. Be sure to only copy/paste the new sampleIDs and RMLs and not previously printed 
ones. 

b. When pasting, right click and choose the second paste option called Paste Values. This 
will adapt the data to the format in the RML file. 

3. Copy and paste the same data two more times, so you have a total of three copies for each 
ID/RML. 

4. Highlight the new data entered. 
5. Select FilePrint. 
6. On the print screen, change the first setting to Print Selection. 
7. Print the labels on the inkjet printer in M/P 1023. Make sure cotton paper is loaded into the 

printer before printing. 
8. Cut apart the printed labels based on the different bags of samples in the shipment. 
9. Add the cut labels to the appropriate bag. 
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Google Drive File 
1. In the Identification Files_2017 samples folder in Google Drive, open the appropriate Domain 

file.  
Note: If this is the first shipment for a Domain, there may only be column headings in this file. 

2. Copy the sampleIDs and RMLs from the _current file and paste them into the Google Drive file. 
3. Make sure the statement All changes saved in Drive appears next to the menu at the top. 
4. Close the file. 

File Check 
After all of these steps, you should have created one new file and modified five others. 

Created: 
1. Shipment#_Domain #_DDMonYYYY.xlsx 

Modified: 
1. RML128XXX (Google Drive) 
2. Shipment#_Domain #_current.xlsx 
3. Shipment#_Domain #_RMLs for printing.xlsx 
4. Shipment#_Domain #_identifications (Google Drive) 
5. Shipment#_Receipt file 

Storing the Samples 
Once all data files are created/modified, store the samples in M/P 1017. There are pre-labeled trays for 
each Domain. Place the samples, separated by shipment, into the correct tray. 
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Processing and Identifying Samples 
Processing Ethanol Samples 

1. Log on to the laptop in 1017 using your GSU credentials.  
a. You can use a personal laptop if desired, but keep in mind that there is a chance of 

chemical spills. 
2. Using your preferred web browser, open and log in to Google Drive. 
3. Navigate to the NEON files that have been shared with you. 
4. The NEON samples are bagged in small batches, usually based on the original shipment. These 

bags are sorted into bins by Domain. This sample baggie should contain a set of labels for those 
vials. If the labels are missing or there are not enough, you can print new ones using the printer 
in 1023. (See Printing Vial ID and RML Labels) 

5. Open a bag of samples and remove the vials and labels. 
6. Cut the labels apart by row. There should be three to four copies of each Vial ID/RML set. 
7. The sample vials are labeled using the Vial ID, which is assigned by NEON. Match the cut apart 

labels to the sample vials. 
8. Select a sample to process.  
9. Prepare archival vials for the samples. For each NEON sample, you will need up to four 1 mL 

shell vials and up to four 8ml vials (with black lid). The shell vials will eventually be placed into 
the 8ml vials.  

10. Put a label set for that sample into each of the 8ml vials. 
a. You may be short one label set at this point. This is okay. It is very unlikely you have up 

to four samples. If needed, you can print a fourth copy of the label set. 
11. Dump the NEON sample into a petri dish. If there is a large amount of sample media, you can 

fish out the specimens using a large pipette or forceps. 
12. Make sure all of the specimens made it into the dish. Double check the sample lid and the 

sidewalls of the vial.  
Keep in mind that larvae in particular are very small and sneaky! 

13. Using a microscope, sort and count the tick specimens by life stage. 
a. If you have been trained by Dr. Beati, you may also identify samples to Genus/species at 

this time. 
14. In Google Drive, open the identification file for the Shipment#_Domain you are currently 

working on. 
15. Record the counts for each life stage on the appropriate row for the sample. 

a. For samples with multiple life stages, you will need to duplicate the row. Add a new row 
below the one for your sample and copy/paste the NEON identifier, Shipment#_, and 
the RML into this new row. 

b. If you are identifying the samples as you go, you should also record the identification at 
this time. If there is more than one species present in a vial, you will need to duplicate 
the row. Every life stage/species combination should have its own row in the file. 

16. Every life gender/stage/species combination should be placed into their own archival vial. Place 
the counted specimens into the shell vial (shell vial = internal vial) containing ethanol along with 
a label containing the life stage/gender. Always use a pencil or a Pigma pen to write the count 
onto the pre-prepared life stage/gender labels. 
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17. Counting larvae: if a vial appears to contain <200 specimens, the ticks in that vial have to be 
manually counted. If the number appears to be more important, ticks are placed in shall vials 
that have been calibrated for approx. number of larvae/volume. Although not perfect, this 
method allows in general for less than 2-5% error (as verified with counted large batches of 
ticks).  

18. Top off the shell vial with 90% ethanol. 
19. Place the shell vial into a 8ml vial (=external vial). The 8ml vial should already contain a set of 

vial ID and RML labels. 

20.  
21. At this point, you do not need to fill the 8ml “external” vial with ethanol. That will wait until 

after the samples have been verified by Dr. Beati. 
22. Notify Dr. Beati via email when the sorting/counting for one shipment is complete. 

Dr. Beati identifies the samples, records IDS on a paper spreadsheet, adds an identification (genus, 
species, gender/stage, amount) label in the shell vial and a barcode (USNMENT#) provided by the 
Smithsonian Institution in the 8ml vial. Dr. Beati, also enters the data into the Google identification 
spreadsheet (separated by shipment) and fills up the 8ml vial with ethanol.  

 

 

23. Place completed samples back into their appropriate tray (separated by shipment). 
24. Discard any unused ethanol from the original sample in the waste container after verifying that 

no ticks are left). 
25. Once an entire Shipment# is complete, download the identification file from Google Drive and 

add the term “_complete” to the saved file name and the Google Drive file name. 
26. Print the file and place it with the samples. 
27. Move on to the next shipment. 
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QA Evaluations  
 

On a yearly basis, once all ticks are counted and identified, and before nymphs are shipped to the 
testing laboratory, the quality of the work performed is tested as follows:  

1) The “random” function in excel is used to assign random numbers to each database entry. These 
numbers are then sorted in ascending order and the first samples corresponding to 3% of the 
total number of entries are selected. 

2) The selected samples are recovered, ticks are recounted and identifications verified. 
Discrepancies are recorded (if any) and the following equations are used to evaluated quality of 
work. 

 

 

Equation 1, Percent Difference in Enumeration (PDE):  

  𝑃𝐷𝐸 =  (|𝐶𝑜𝑢𝑛𝑡1−𝐶𝑜𝑢𝑛𝑡2|/|𝐶𝑜𝑢𝑛𝑡1+𝐶𝑜𝑢𝑛𝑡2|)  𝑥 100  

  

Equation 2, Percent Taxonomic Disagreement (PTD):  

  𝑃𝑇𝐷 =  (1 – (𝑎𝑔𝑟𝑒𝑒𝑚𝑒𝑛𝑡𝑠/𝑁)  𝑥 100  

Where: agreements is the number of consistent identifications (species and sex match; if 

species and sex are identical, but identification qualifier differs, that is still considered 

an agreement); N is the total number of individuals in the larger of the two counts. 

 

 

Printing Vial ID and CEN/RML labels 
1. Log on to the computer in M/P 1023 that is hooked up to the printer. 
2. Make sure the printer is loaded with archival ethanol-resistant paper. There is additional paper 

in the desk drawers if it is empty. 
3. Log in to Google Drive and navigate to the NEON folder that has been shared with you. 
4. Open the folder for the year you are currently working on. 
5. Open the folder for the Domain you are currently working on. 
6. Download the Domain #_RMLs for printing file. 
7. Open the downloaded file in Excel. 
8. Once opened in Excel, highlight the label(s) you need to print. 
9. Open the File menu and select Print 
10. BEFORE printing, change the first drop down menu under Settings to Print Selection. 
11. Verify that the print preview on the right shows the label(s) you need to print. 
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12. Verify that the print job is going to the HP Envy printer. 
13. Click “Print” 

 

Processing an identified and verified shipment. 
All identifications must either be performed or verified by Dr. Beati. She will write her ids directly onto 
the paper spreadsheets printed by the students when they complete the initial processing of a 
shipment. The identifications will then need to be entered into the spreadsheets (Dr. Beati has been 
doing this since 2019, but students will start entering identification data again in 2022). These files must 
be processed in a timely fashion.  

1. Open the Shipment #_identifications_complete file for the shipment you are entering. You may 
need to download this from Google Drive. 

2. Using the handwritten notes, transcribe the species names into the file in the Genus and species 
columns. Make sure the RML and barcode numbers match. 
Note: since the spreadsheet was printed from this file, the records should be in the same order. 
You may need to rearrange the pages. 

3. If more than one species was identified out of a batch, you will need to duplicate the row. Insert 
a new blank row and copy/paste the vialID and RML. Enter all other data, including the barcode 
Dr. Beati assigned. 

4. Update the date and identifier fields for all records identified by Dr. Beati. 
5. Once the file is complete, save it as an Excel file using the following naming format: 

Domain #_identifications_complete_LB 
6. Use this file to create the data files. 
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Data and Invoice Files for NEON 
Creating Data Files for NEON reports (sent to NEON within 3 months from shipment 
receipt). 
Domain Files 

1. Open the Domain #_identifications_complete_LB file and the Domain #_current file in MS Excel. 
2. Split screen the files. 

a. On a PC, you can drag the window to the center of either side of the screen to “snap” 
the windows into place. 

3. Sort both files by RML.  
a. Click the Data tab 
b. Click the Filter button 
c. Click the arrow next to the RML heading. 
d. Select the Sort A to Z option. 
e. Do this for both files. 

4. In the _complete_LB file, select column B (CEN/RML) and set it to highlight all duplicate values. 
a. On the Home tab, select Conditional FormattingHighlight Cells RulesDuplicate 

Values 
b. In the window that appears, click okay. 
c. All duplicate RMLs should now be highlighted in red. 

5. The _current file has each vialID/RML combination listed once. Some of these will need to be 
duplicated to match the _complete_LB file. Insert a blank row below each record that needs to 
be duplicated. Insert more than one if needed. The number of rows per record should match the 
_complete_LB file. 

6. Copy and paste the data from column B in the _complete_LB file into column D in the _current 
file, so you can verify you inserted the new rows correctly. Do not copy and paste the header. 

7. Fix any mistakes you notice.  
8. Copy/paste the sampleID and RML down into each blank row. Do not drag data down, as it will 

increase any numbers by 1. 
9. Set the RML column in _current to highlight duplicate values. Verify that the blocks of 

highlighted cells match the data you copy/pasted in from the _complete_LB file. 
10. Clear Rules in _current 

a. HomeConditional FormattingClear RulesClear Rules from entire sheet 
11. Delete the data out of column D in the _current file. Do not delete the header. 
12. Copy and paste all columns from the _complete_LB file into the _current file. Make sure you are 

pasting data into the correct places.  See Table 2. 

Table 2: Origin in _complete_LB, Destination in _current 

Column in _complete_LB Data contained Column in _current 
C Genus K 
D Species M 
E Life stage/sex P 
F Counts Q 
G Identified Date A 
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H Identified by AA 
I Barcode Number T 
J Remarks AB 

13. Double check that the data in _current matches the data in _complete_LB and that nothing is 
scrambled. Data checks are performed when data are converted to the final format (Tick IDs and 
Archival files). 

14. If everything is okay, close out of _complete_LB. 
15. Fill out the remaining columns in _current. Note: many will be left blank as it is data we do not 

report. See Table 3. 

Table 3: Data for Remaining Columns in _current 

Column Letter Column Heading Actions 
E Target Taxa Present Fill Y all the way down, unless there was 

something barcoded that is not a tick. In that case, 
use N. 

F Species Name 1. Sort file by Genus. 
2. Fill in the following formula: 

=J#&” “&L# 
3. Drag down for all records with an ID 
4. Copy and paste values on top of itself (this 

will delete the formula) 
G Family Fill in Ixodidae for anything with an identification.  
R Sample condition OK or Damaged 
S Archive Medium 90% ethanol or RNA stabilization buffer 
T Archive facility ID Needs to be in the following format: 

USNMENT######## 
Correct if needed 

V Subsample ID 1. Fill in the following formula: 
=B#&”.”&left(J#, 3)&left(L#, 3)&”.”&left(O#, 1) 

2. Drag down for all records. 
3. Copy and paste values* on top of itself 

(this will delete the formula) 
4. In column V fill in the following formula: 

=upper(U#) 
5. Drag down for all records. 
6. Copy and paste values from column V into 

column U. 
7. Delete all data in column V. Do not delete 

the header. 
8. Highlight column U 
9. Open the Find/Replace tool (cntrl F) 
10. In the replace tab, set “Find what” to “..” 

and “Replace with” to “.” 
11. Click Replace All. 
12. Close Find/Replace 
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W Subsample fate archived 
X and Y Scientific Name 

Authorship and 
Identification 
References 

1. Highlight the data and open the sort 
menu. 

2. Set “Sort by” to Genus 
3. Add a second parameter by clicking “Add 

Level” 
4.  Set “Then by” to specific epithet 
5. Click OK 
6. Hide all columns in between the 

Genus/Species and the current columns. 
7. Open the Species Authors and Resources 

file 
8. Copy and paste the authorship and 

references information. 
9. Be sure to Copy/Paste for each record, do 

not drag down as that will increase 
numbers by 1. 

10. Close the Species Authors and Resources 
file. 

Z Identification 
Protocol Version 

Always: GSU_tickIdentification_SOP_2016-11-01 

AA Identified by 1. Open Find/Replace tool (cntrl F) 
2. Click on the Replace tab 
3. Set “Find What” to the name you need to 

expand 
4. Set “Replace With” to the full name of 

that person 
5. Click Replace All 
6. Repeat for each person listed in the 

Identified by column. 
7. Close Find/Replace 

AB Remarks For anything not being invoiced, put “Over invoice 
limit, will not be billed.” 

*To Paste Values:  
1. Copy something to your clipboard (Do not Cut) 
2. Right click where you want to paste. 
3. Under “Paste Options” select the icon for Paste Values. 
 

16. Sort the file by RML. 
17. Save the file.  
18. Save a second time, replacing _current with the day’s date in DDMonYYYY format. 
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Table 4: Data Dictionary for NEON Files 

Field Name Required Format Example Notes 
identifiedDate N YYYY-MM-DD 2013-09-12  

sampleID Y SITE_###.YYYYMMDD HARV_003.20130712 sampleID reported by Field Operations 

sampleCode N [A/B]########### A00000001347 
Barcode assigned to sample vials before 

shipment. May start with either the letters 
A or B followed by a string of numbers 

targetTaxaPresent Y Y/N Y  

scientificName N Genus species Ixodes scapularis  
family N  Ixodidae  

subfamily N  Ixodinae Ignore, Leave blank 
tribe N  Ticktribe Ignore, Leave blank 

subtribe N  Ticksubtribe Ignore, Leave blank 
genus N Genus Ixodes  

subgenus N  Ticksubgenus Ignore, Leave blank 
specificEpithet N species scapularis  

infraspecificEpithet N sub species forma Beati  

identificationQualifier N  aff. species  

instar 
if targetTaxaPresent = 

Y, Y 
Male/Female/Nymph/Larv

ae 
Male  

individualCount N # 1 integer >= 0; leave blank if uncounted 

sampleCondition Y 
OK/Damaged, analysis 

affected/Handling 
error/Other 

Damaged, analysis 
affected 

 

archiveMedium Y 

RNA stabilization 
buffer/95% 

ethanol/Other/90% 
ethanol 

RNA stabilization 
buffer 
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archiveFacilityID N USNMENT######## USNMENT00853485 Equivalent to internalLabID1 

deprecatedVialID N 
SITE_###.YYYYMMDD.#.Ge

nus species 
HARV_003.20130712.
1.3.Ixodes scapularis 

What is on the tube label only if it does not 
match the sampleID; Usually blank 

subsampleID Y 
SITE_###.YYYYMMDD.GEN

SPE.I 
HARV_003.20130712.I

XOSCA.M 
 

subsampleFate Y archived/active/lost archived 
Most samples will be "archived", those sent 
for testing will be "active" - consult NEON 

Science for other situations 
scientificNameAuthors

hip 
N Name, YYYY Say, 1821 See Species Authors and Resources file 

identificationReference
s 

N [citation for key used] [citation for key used] See Species Authors and Resources file 

identificationProtocolV
ersion 

Y 
GSU_tickIdentification_SOP

_YYYY-MM-DD 
GSU_tickIdentification

_SOP_2016-11-01 
Currently always: 

GSU_tickIdentification_SOP_2016-11-01 
identifiedBy N First Last Lorenza Beati  

 



14 | P a g e  
 

NEON Invoices 
Invoices are prepared at the beginning of the month for the previous month’s work. Identifications must 
be completed or verified by Lorenza Beati in order to be billed. We charge per identification for adults 
and nymphs. Larvae are charged as one for each batch that is counted. We do not identify the larvae. 

Billing has been done by Dr. Beati since 2019. She will keep doing this in future. 

1. Open the file that needs to be billed in Microsoft Excel. This will be the Shipment’s _current file. 
2. Click on the Data tab. 
3. Select Filter. This will make it possible to sort the file quickly. 
4. Click the arrow next to the Instar heading and select Sort A to Z. 
5. Click the arrow next to the Instar heading again and uncheck the term “larvae” from the list. 

Click OK.  
6. Open the NEON Billing Template. 
7. Copy and paste the contents of column V (subsampleID) in the identification file into column C 

(Ticks in vials) in the billing file. Because the larvae are filtered out they will not be pasted over 
at this time. 

8. Copy and paste the contents of column Q (individualCount) from the identification file to 
column F (Quantity) in the Billing file.  

9. Copy and paste the contents of column A (Identification Date) into column B (Identification 
Date). 

10. Click the arrow next to the Instar heading again. Recheck the term “larvae” from the list and 
uncheck all other terms. Click OK.  

11. Copy and paste the contents of column V (subsampleID) in the identification file into column C 
(Ticks in vials) in the billing file. Because the adults and nymphs are filtered out they will not be 
pasted over at this time. 

12. Enter “1” as the Quantity for all larvae.  
13. Copy and paste the contents of column A (Identification Date) into column B (Identification 

Date). 
14. Click on the arrow next to the Instar heading and select Clear filter from instar. 
15. Save the file three different ways: 

a. Save as “Shipment #_DDmonYYYY”, where the date is the current day’s date 
b. Save in the “Identified and Billed” folder for that domain with the file name “Domain 

#_DDmonYYYY_invoiced” 
c. Delete the contents of the file, leaving only the column headings and save it as “Domain 

#_current” 
16. If there are other Domains to invoice for this cycle, repeat steps 1-15. Otherwise move on. 
17. Column A of the Billing file has two statements: “Identification to species with long-term storage 

and curation” and “Larval count with long-term storage and curation”. All of the adults and 
nymphs should have column A populated with the first statement. All larvae should have 
column A populated with the second. 

18. In column D (Location Collected), drag the first populated cell down to copy the formula to all 
cells. The column should populate with the first four letters of the vial code in column C. 

19. In Column E (Individual cost), populate the entire column with “amount applicable for that 
year”. Do not drag this down as it will increase by 1 each time. 
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20. In Column G (Total Cost), drag the first populated cell down to copy the formula to all cells. This 
formula should multiply column E (Individual Cost) by column F (Quantity). 

21. Scroll to the very bottom of the data.  
22. In the first empty cell for column F (Quantity), get the sum of the column. Do the same for 

column G (Total Cost) 
23. Double check the math for the sum of the total cost by multiplying the sum of the quantity by 

15. 
24. In column H (Date Invoiced), enter the date you are preparing the invoice. 
25. Save the entire file using the following naming scheme: NEON_billing_DDMonYYYY (the day and 

year are both digits, the month is the first three letters of that month’s names. 

Send the completed invoice file to Jennifer Dippolito (jdippolito@georgiasouthern.edu), accountant (in 
Research Accounting), and Krista Brinson (kmbrinson@georgiasouthern.edu), Associate Director for 
Financial Accounting and Sponsored Programs, Office of Research Services and Sponsored Programs and 
CC Melissa Gast Goodman, the ICPS administrative coordinator (mgoodman@georgiasouthern.edu). 

Files for Upload 
When an invoice is sent to NEON a matching data file needs to be uploaded the NEON data portal. 
Report to NEON all counts and ids, including those that are not billed. 

1. Open a blank data template file. 
2. Open the _DDmonYYYY_invoiced file for each Domain included in the invoice. 
3. Copy and paste records from the _DDmonYYYY_invoiced file into the blank template file. 
4. Repeat for all Domains that were invoiced. 
5. Remove column C (RML) 
6. Save as a CSV file with the file name: tck_identification_in_GSU_YYYYMMDD (the date is the 

date of the invoice) 
7. Upload the file to the NEON data portal* 

*Note:  You must have an account with NEON in order to access the data portal. As of August 2018, only 
Lorenza has account. 

Creating USNTC FileMaker Files from NEON Files 
Once files are uploaded to the Box, the file needs to be rearranged and reformatted for upload into the 
FileMaker-USNTC database. 

Some of the fields will be discarded during the import process and can be ignored. Do not delete these 
fields. Additional fields will need to be added. See the table on the following page for the list of fields to 
be discarded and new fields to be added.  
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Table 5: Specify Workbench File 

Field Name Required Format Example Notes Keep/Discard/Add Specify field 

identifiedDate N YYYYMMDD 2013-09-12 
Convert to 
MM/DD/YYYY format 

Keep Determination: 
Determined Date 1 

sampleID Y 
SITE_###.YYY
YMMDD 

HARV_003.201307
12 

sampleID reported by 
Field Operations 

Discard -- 

RML  N ###### 125555 
For GSU use only. Not 
reported to NEON 

Keep Collecting Information: 
RML/CEN 

targetTaxaPresent Y Y/N Y  Discard -- 

scientificName N 
Genus 
species 

Ixodes scapularis  
Discard -- 

family N  Ixodidae  Discard -- 

subfamily N  Ixodinae Ignore, Leave blank Discard -- 

tribe N  Ticktribe Ignore, Leave blank Discard -- 

subtribe N  Ticksubtribe Ignore, Leave blank Discard -- 

genus N Genus Ixodes  Keep Determination: Genus 1 

subgenus N  Ticksubgenus Ignore, Leave blank Discard -- 

specificEpithet N species scapularis  
Keep Determination: Species 

1 

infraspecificEpithet N sub species forma Beati  
Keep Determination: 

Subspecies 1 
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identificationQualifier N  aff. species  
Keep Determination: Qualifier 

1 

instar 

if 
targetTax
aPresent 
= Y, Y 

Male/Female
/Nymph/Larv
ae 

Male 
For Specify, rearrange 
into columns 

Keep Collection Object 
Attributes: #males; 
#females; #nymphs; 
#larvae 

individualCount N # 1 
integer >= 0; leave blank 
if uncounted 

Keep* Insert counts into 
appropriate previous 
columns 

sampleCondition Y 

OK/Damaged
, analysis 
affected/Han
dling 
error/Other 

Damaged, analysis 
affected 

 

Discard -- 

archiveMedium Y 

RNA 
stabilization 
buffer/95% 
ethanol/Othe
r/90% 
ethanol 

RNA stabilization 
buffer 

 

Keep Preparations: Prep Type 

archiveFacilityID N 
USNMENT##
###### 

USNMENT0085348
5 

Equivalent to 
internalLabID1 

Keep Collection Object: 
Catalog Number 

deprecatedVialID N 
SITE_###.YYY
YMMDD.#.Ge
nus species 

HARV_003.201307
12.1.3.Ixodes 
scapularis 

What is on the tube 
label only if it does not 
match the sampleID; 
Usually blank 

Discard -- 
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subsampleID Y 
SITE_###.YYY
YMMDD.GEN
SPE.I 

HARV_003.201307
12.IXOSCA.M  

Keep Collection Object: Alt 
Cat Number 

subsampleFate Y 
archived/acti
ve/lost 

archived 

Most samples will be 
"archived", those sent 
for testing will be 
"active" - consult NEON 
Science for other 
situations 

Keep Collection Object 
Attribute: Deposition 

scientificNameAuthors
hip 

N Name, YYYY Say, 1821 
See Species Authors and 
Resources file 

Discard -- 

identificationReference
s 

N 
[citation for 
key used] 

[citation for key 
used] 

See Species Authors and 
Resources file 

Keep Determination: 
nameaccordingto 

identifiedBy N First Last Lorenza Beati 
For Specify separate 
into three columns 

Keep Determination: 
Determiner first name 1; 
Determiner last name 1; 
Determiner middle 1 

Remarks N    
Keep Collection Object 

Attribute: Remarks 

Cataloger first N    
Add Collection Object: 

Cataloger first name 

Cataloger last N    
Add Collection Object: 

Cataloger Last Name 

Cataloger middle N    
Add Collection Object: 

Cataloger Middle Initial 
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Cataloged date N 
MM/DD/YYY
Y 

09/12/2013  
Add Collection Object: 

Cataloged Date 

Count 1 Y    Add Preparation: Count 1 
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Archiving Samples 
Printing NEON labels 

1. Log into Specify. 
2. Click the Reports icon. 
3. Under the Labels heading on the left, select the appropriate label. There are three to choose 

from for NEON: 
a. NEON labels 
b. NEON locality only 
c. NEON ID only 

4. In the window that appears, use the fields listed to create the labels you need. You will use 
either the barcode number (labels and ID only) or the RML (locality only) 

a. Use the drop-down menu of operators as needed. The most useful is ‘Between’ which 
allows you to set ranges. 

5. Click OK to run your Report. It will take a moment to load.  
6. Zoom in on the labels to make sure they populated properly and that none of the text is 

truncated or overlapping. 
7. Select the Printer icon at the top of the workspace to print your labels. 

a. Alternately, you can choose to print to PDF at this point and save the labels, so they can 
be printed later or from a different computer. 

8. Print the labels in 1023 using the computer that is hooked up to the ink jet printer. The printer 
should be loaded with cotton paper, not standard paper. 

9. Carefully cut apart the labels. If you printed both label types at once, be careful not to separate 
the two labels. 

10. Insert the labels into the sample vial. The locality label should face out against the glass. The 
identification label nests behind the locality label with the text facing into the vial. 

 

Arranging Samples into Archival Jars 
Samples are grouped into archival jars by site, not just domain. Up to five scintillation vials can fit into 
one jar. As jars are created they should be labeled “SITE YYYY Jar #”. Write the labelling on the top of the 
lid using pencil. Once all jars for a Domain are completed, print the jar names using the label maker. 

Arrange the jars in the drawers by Domain and year. As drawers are filled, label the outside of the 
drawer with the range of Domains for that year.  
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Subsampling for Disease Testing 
Preparing Samples for Shipment to UMass 
Only nymphs are shipped to University of Massachusetts for disease testing. Instructions for which 
samples to send will be received from NEON. 

1. Consult the second page of the file ticksForPathogenTesting2017_counts added.xlsx or the 
printed list of samples. 

2. Select a sample for preparation. 
3. Choose specimens for archiving (retained). Try to select ones that are fully intact with 

mouthparts and all legs still attached. Place these back into the archival vial. 
4. Place each individual specimen in separate 2ml sterile Eppendorf vials with NO ETHANOL. Verify 

simultaneously that counts are correct. 
5. Place batches of ticks corresponding to single NEON collection events in small sealable plastic 

bags. Place the sampleID label and nymph count into the shipment plastic bag. If more than a 
species is contained in a batch, create separate and add the name of the species to the label. 

6. Bags from same site and same species are placed in larger sealable bags. 
7. Place the “# nymphs sent to UMass…” label into the archival vial. 
8. Top off the archival vials with sample media (90% ethanol). 
9. Repeat steps 2-8 for each sample to be prepared. 
10. Return archival vials to their original location. 
11. Group the samples for shipment by Domain. 
12. Pack bagged samples into a cardboard shipping box.  
13. Add enough air bags to cushion the samples while in transit. 
14. Send Lorenza any corrections to the nymph counts, if needed.  
15. Once all samples are prepped, contact Lorenza so she can ship the samples. 

 


